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Safety precautions

Introduction
Proper installation, operation and maintenance are essential to ensure 
safety during the use of your CommStaff. Do not use CommStaff before 
completely reading and fully understanding the safety precautions 
explained in this manual, and be sure to follow the instructions on 
installation, operation and maintenance.

Verifying your order
Upon receiving CommStaff, check that the specifications match what you 
ordered, and check for any damage to the product that might have occurred 
during shipping.
Verify that the package contains the following items:
･	 Installation CD-ROM
･	 Quick start guide
･	 CFS100 SFN/DE communication interface (optional)

Transporting CommStaff
To avoid damage, transport CommStaff in its original packaging until it 
arrives at the installation site.

Storing CommStaff
Select a storage site that satisfies the following conditions:

･	 Not exposed to rainwater

･	 Not subject to vibration or shock

･	� As close as possible to normal temperature and humidity (approx. 25°C 
and 65% RH)

Store CommStaff in its original packaging if possible.

Use of cellular phone or radio transceiver
Using a cell phone or radio transceiver near CommStaff may affect 
CommStaff's performance due to radio interference, depending on the 
transmitting power and the frequency.

Model: CFS100 - Field Communication Software "CommStaff"
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Chapter 1. Overview

1-1.	 Introduction
CommStaff is a tool for communicating with Yamatake smart field devices (DSTJ and 
others) that enables configuration of device settings. It is a software product that operates 
on Windows PCs. CommStaff communicates with Yamatake smart field devices using a 
USB interface connected to a Windows PC, which is then connected by communications 
cable to the USB port of a device.

CommStaff supports Yamatake’s proprietary SFN/DE communication protocol as well as 
the HART communication protocol.

*HART is a registered trademark of the HART Communication Foundation.

1-2.	 Important Notes
*	 When changing connected devices
	� CommStaff continues communicating with the device when displaying dynamic 

values, such as pressure, so that it can continuously update these values. If you remove 
the communications cable to change the device during this communication, an error 
will occur.

	� Exit CommStaff before detaching the communications cable from the device, and then 
start CommStaff again after connecting the communications cable to the new device.

*	 Do not use CommStaff while the PC is connected to AC power.

*	� If the plastic case of the communication interface becomes cracked, do not use 
CommStaff .

*	� Handling the communication interface cable clamp unnecessarily may lead to 
malfunction of the latch. Handle the cable clamp only as necessary.

1-3.	 Package Contents and Part Names
The CommStaff product consists of the following items.

•	 Installation CD-ROM
	� The CD-ROM contains an installer to install the CommStaff application on your 

Windows PC. It also includes the operating manual and the instruction manual of the 
device in PDF format.

	 Store the CD-ROM away from direct sunlight.

•	 Quick start guide
	 A simple guide for initial setup of CommStaff.

•	 CFS100 SFN/DE communication interface (optional)
	� A USB-type SFN/DE communication interface. Connect this interface to a USB port 

on the PC.

Caution: �Do not connect the communication interface before you have installed 
the CommStaff software on the PC. Otherwise, the interface will fail to 
find the driver and the program will not operate correctly.

1-4.	 Operating Environment
•	 Use CommStaff within the following ranges.
 	 Environmental conditions (CFS100 SFN DE communication interface)
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		  Operating temperature 0 to 50 °C; operating humidity 5 to 95 %

Note: �If the PC has a more limited operating environment range, use CommStaff within 
that range.

1-5.	 System Requirements

1-5-1.	 PC
Use a PC that meets the following requirements.

OS Windows 7
32-bit 
Professional 
Japanese or English version

CPU Earlier than the 2010 Core i series

Hard disk drive space 500 MB or more

Communication port USB 2.0 or later

Although CommStaff was also designed for use with Windows XP, operation with 
Windows XP has not been tested.

1-5-2.	 Communication Interface
Use a communication module that meets the following requirements.

SFN/DE communication interface CFS100 SFN DE
   Yamatake model number:  
	 80345962-001

HART communication interface MACTek VIATOR USB HART Interface
   MACTek model number: 010031

Regarding the HART communication interface, although CommStaff was designed for 
use with other similar products, operation with other products has not been tested.
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Chapter 2. Installing/Uninstalling CommStaff

2-1.	 Preparation for Installation

2-1-1.	 Items Required
Have the following items on hand before beginning installation.

•	 PC
	 * Check that it meets the system requirements described in Section 1-5-1.
	 * A CD-ROM drive is necessary for installation.

2-2.	 Installation

2-2-1.	 Installation Overview
1.	 Put the CommStaff installer CD-ROM in the CD-ROM drive of the PC.

2.	 Execute the following two installers.
	 1)	 CommStaff application installer
		�  Run Setup.exe, located in the root directory of the installer CD-ROM. (For correct 

installation in the case of an upgrade, first uninstall the old version and then install 
the new version.)

	 2)	 SFN communication interface driver installer
		�  Run CFS100SFNInstaller.exe, located on the installer CD-ROM in the 

¥CustomCFS100SFNDriverInstall subfolder.

3.	 If using the HART communication interface, install the driver supplied with it.

This completes the installation.
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2-2-2.	 Installation in Detail
Installation of the CommStaff application
Execute Setup.exe in the root directory of the installer CD-ROM.

The message “Do you want to allow the following program from an unknown publisher 
to make changes to this computer? ” appears. Click [Yes].

The language selection screen appears. Click [OK] to continue.
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Click [Next].

Read the License Agreement. If you accept the terms of the License Agreement, select “I 
accept the terms in the license agreement” and click [Next] to continue.
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Enter the user name, organization, and license key, and click [Next] to continue.

The serial number. is printed on the sticker on the CommStaff Installer CD-ROM case as 
a license key.

Click [Install].
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Click [Finish].

This completes installation of the CommStaff application.
Next, install the driver for the SFN communication interface.
Run CFS100SFNInstaller.exe in the ¥CustomCFS100SFNDriverInstall subfolder of the 
installer CD-ROM.

Click [Install].
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Click “Install this driver software”.

Click [OK].

This completes installation of the SFN communication interface driver.
If using the HART communication interface, install the driver software supplied with it.

2-3.	 Uninstalling CommStaff
In the Windows Control Panel, go to Programs and Features and delete the target 
application program from the program list.
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Chapter 3. �Checking the Communication Interface 
Connection

On completion of software installation, check the communication interface connection.

1. 	Connect the communication interface to the USB port of the PC.

2. 	�If the driver software was installed correctly, the PC recognizes the communication 
interface as a COM port.

3. 	�In Control Panel, open the Device Manager and verify that the communication 
interface is recognized by the PC correctly.

	� Open the ports (COM and LPT) and check that the connected communication module 
is recognized correctly.
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Chapter 4. �Starting and Exiting the Application and 
Starting Communication

4-1.	 Starting the Program
1. 	Select Start → All Programs → CommStaff → CommStaff to start the application.

2.	 The User Account Control screen appears. Click [Yes].
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4-2.	 Starting Communication
When CommStaff starts, the following screen appears.

4-2-1.	 HART Communication
To start HART communication, click [HART Communication].
The HART-related COM ports that are currently connected are listed on the screen. Select 
the desired COM port and click [OK].
This COM port number is assigned automatically to the CommStaff serial port number 
setting.

CommStaff screen appears and information about the connected device is displayed.
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If communication fails due to some problem, such as no device being connected to 
the communications cable, the message “ERROR: Failed to acquire a device identity.” 
appears on the status bar on the bottom left of the window.
Check the device connection.

For more information on the device in question, refer to the instruction manual of the 
device.

*	 When changing connected devices
	� CommStaff continues communicating with the device while it is operating. A 

communication error will occur if you remove the communications cable from the 
device in order to change to another device. 

	� First, exit CommStaff and then remove the communications cable from the device. 
Start CommStaff again after you have connected the communications cable to the new 
device.

	� The following message appears if you remove the communications cable while 
CommStaff is operating.

	 “Error In Communication with Device, Closing the Device…”

	 When [OK] is clicked, all displayed data disappears.



14

4-2-2.	 SFN/DE Communication
To start SFN/DE communication, click [SFN/DE Communication].

The SFN/DE-related COM ports that are currently connected are listed on the screen. 
Select the desired COM port and click [OK].
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When using SFN/DE communication, the output current from devices that output current 
fluctuates. The following message appears asking you to confirm that you are aware of 
this fact. Click [Yes] to continue.

A message appears that asks you to confirm that data should be collected from the SFN 
device. Click [Yes] to continue.

If communication fails due to some problem, such as no device being connected to 
the communications cable, the message “Procedure terminated because there was no 
response.” appears on the CommStaffControl screen.

Check the device connection.
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When using SFN/DE communication, CommStaffControl converts between the SFN/
DE communication and HART communication protocols using a virtual communication 
port for relaying communication. The following message confirms that the virtual 
communication port has been created and displays the port number. Click [OK] to 
continue.

This COM port number is assigned automatically to the CommStaff serial port number 
setting.

CommStaff starts and information about the connected device is displayed.

For more information on the device in question, refer to the DD (Device Description) of 
the device.
*	 When changing connected devices
	� CommStaff continues communicating with the device while it is operating. A 

communication error will occur if you remove the communications cable from the 
device in order to change to another device. 

	� First, exit CommStaff and then remove the communications cable from the device. 
Start CommStaff again after you have connected the communications cable to the new 
device.

	� The following message appears if you remove the communications cable while 
CommStaff is operating.

	 “Error In Communication with Device, Closing the Device…”
	 When [OK] is clicked, all displayed data disappears.

4-3.	 Exiting the Application
When your work is complete, exit the CommStaff application first and then exit the 
CommStaff Control program.



17

4-4.	 When the device status is ON
When the device is ON, the following screen is displayed.Click the [Ignore] button.Next, 
check the device status details as necessary.─For details see section 6.1.2, “View Menu.”
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Chapter 5. Basic Operation of CommStaff

This chapter describes the basic operation of CommStaff.

CommStaff uses an Explorer-type screen configuration. A menu tree appears in the left 
pane and details of the item selected in the menu tree appear in the right pane.

CommStaff has four menus (Device, View, Window, and Help) and eight icon functions.
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5-1.	 Displaying a List of Main Data Items
To display a list of main data items, select Review in the menu tree.

First, right-click Online in the left pane and select “Expand.” The expanded menu tree is 
displayed in the left pane.

Select Review from the expanded menu tree. A list of main data items appears in the right 
pane.
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5-2.	 Changing Settings
To change data item settings, double-click the item in the right pane. Note, however, that 
only the settings of boldfaced data items can be changed. The settings of grayed-out data 
items cannot be changed. Also note that data settings cannot be changed in the Review 
pane.

For example, the basic data items for the AT9000 (GTX) device are contained in Basic 
Setup.

To change the setting for Upper Range Value (100%), double-click that item in the right 
pane as shown above. A dialog box enabling you to enter the new setting appears. Enter 
the desired value and click the Config. button.
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The changed value is highlighted in yellow. The value has not yet been applied in the 
connected device. To send the changed value to the device, click the send button. The 
send button has an icon containing an upward arrow and is third from the left in the icon 
menu.

When the changed value is sent to the device, the yellow highlighting disappears.

5-3.	 Adjustment, Calibration, and Loop Tests
Adjustment, calibration, and loop tests require method calls. For more information, refer 
to the instruction manual of the device in question.

Send
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Chapter 6. CommStaff Functions
This chapter describes the menu functions and the icon menu functions in CommStaff.

6-1.	 Description of Menu Functions
CommStaff has four menus: Device, View, Window, and Help.

6-1-1.	 The Device Menu

The Device menu contains the following items.

New This function is not used in normal operation. It resends 
data that disappeared from the screen due to a 
communication error or other reason. (When changing 
connected devices, temporarily exit CommStaff and then 
restart it.)

Save Saves device data to a file. The data can be saved in CSV 
or PDF format.
For more information, refer to Section 6-1-1-1, “Save 
Function.”

Config. Configures communication settings. This function is not 
used in normal operation. For more information, refer to 
Section 6-1-1-2, “Config.”

Exit Exits CommStaff.
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6-1-1-1.	Save Function
This function saves device data to a file. Either of the following two file formats can be 
selected:
	 CSV format, PDF format

The default file names are as follows. The file name can be changed when saving.
	 CSV format:	 tag name_yyyymmddhhmmss.csv
	 PDF format:	 tag name_yyyymmddhhmmss.pdf
	   Example: FIC-001_20100804152348.csv

CSV stands for comma-separated values because in the CSV format, data is saved as 
plain text separated by commas. CSV files can be opened using spreadsheet software such 
as Excel. They can also be opened using a text editor such as Microsoft Notepad.
	   Example:	 PV LRV, 0.00, kPa
			   PV URV,1 00.00, kPa

To open PDF files, software for reading PDF files is required.

Note: �For smart positioners, the default file name for saving will not be the tag name 
but rather tag_number_yyyymmddhhmmss.*** (where *** is the file extension).  
To save with the tag name, input the tag name and save the file.
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6-1-1-2.	Config.
This function is not used in normal operation.

“Serial Port” is configured automatically when a communication interface is selected. Do 
not change this setting.

“Search by Poll Address” is used when the device is connected in a HART multidrop 
topology.

Multidrop topology is the HART communication specification that allows multiple 
devices to be connected to a single current loop.

In this case, only the device with the polling address “0” outputs 4?20 mA analog current.

Devices with polling addresses other than 0 output a fixed current (usually 4 mA). 

When not using the multidrop topology, be sure to select “use poll address 0 only.”

The search time increases as the number of search addresses increases.
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6-1-2.	 View Menu

The View menu contains the following items.

Toolbar Toggles display of the icon menu.
Refer to Section 6-1-2-1, “Icon Menu.”

Status Bar Toggles display of the status bar at the bottom of the 
screen.

Device Condition Displays the device status.
For more information, refer to the instruction manual of 
the device in question.

Event-Status Log Toggles display of the event status log.
Refer to the event status log when an incompatibility 
issue or other similar problem occurs. This function is 
not used in normal operation.

Available DDs Displays all available DDs.
Refer to Section 6-1-2-2, “All Available DDs.”

The items listed below “Online” depend on the contents of the DD of the connected 
device. Refer to the instruction manual of the device.
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6-1-2-1.	Icon Menu
The icon menu contains the following eight items.

New This funct ion is not used in normal 
operation. It resends data that disappeared 
from the screen due to a communication 
error or other reason. (When changing 
connected devices, temporari ly exit 
CommStaff and then restart it.)

Version information Displays information about CommStaff, 
such as the version.

Send Sends data items that have had settings 
changed to a device.

Cancel Cancels changed settings before they are 
sent, and restores them to the original 
settings.

Status Displays the device status.

Event status log Displays the event status log.

Increase font size Increases the font size in the menu tree 
display and the data display panes. This 
function is useful on PCs with small 
screens.

Decrease font size Decreases the font size in the menu tree 
display and the data display panes.

6-1-2-2.	All Available DDs
DD is an abbreviation for Device Description. It is a file describing the parameters of a 
HART device.

The vendor code for Yamatake registered by the HART Communication Foundation is 
0x36 (in hexadecimal), so the vendor code is displayed as Yamatake (0x36).

0x00, 0x26, and 0xf9 contain default DDs provided by the HART Communication 
Foundation.
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6-1-3.	 Window Menu

Cascade Displays multiple open windows in a cascade. An 
example of cascade display is given in (1) below.

Tile Displays multiple open windows in a tile arrangement. 
An example of tiled display is given in (2) below.

Arrange Icons When windows are minimized, they are arranged as 
small icons at the bottom of the screen. An example of 
arranged icons is given in (3) below.

The items listed below “Online” are the currently open windows.

(1) Example of cascade display
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(2)  Example of tiled display

(3)   Example of arranged icons
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6-1-4.	 Help Menu

The Help menu contains the following items.

About 
CommStaff

Displays information about CommStaff, such as the 
version. Refer to Section 6-1-4-1, “About CommStaff.”

6-1-4-1.	About CommStaff
This function displays the CommStaff version, copyright, license key, and other 
information.
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Chapter 7. Troubleshooting
If you encounter a problem, please review the following “Troubleshooting Checklist” 
before contacting Yamatake.

7-1.	 Troubleshooting Checklist
1.	� Is the connected device supported by (compatible with) CommStaff?

2.	� Does a similar problem occur when another device is connected? If a similar problem 
does not occur when another device is connected, there may be something wrong with 
the connected device or the connection loop.

3.	� Is the communication module connected correctly?

4.	� Does the PC meet the system requirements recommended by Yamatake?

5.	� Are other application programs running at the same time? If so, exit the programs and 
restart CommStaff.

6.	� If the problem persists after checking the above items, restart the PC and then restart 
CommStaff.

7.	� Does the CommStaff application start up? If CommStaff does not start up, there may be 
a problem with the PC. If programs other than CommStaff do not start either, it is likely 
that the problem is the PC.

7-2.	 If CommStaff Freezes
If the screen freezes for some reason during operation and you cannot operate CommStaff, 
restart your PC.

7-3.	 Incompatibility
If a problem occurs due to incompatibility, contact your Yamatake sales representative.
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7-4.	 Known issues 
We are already aware of the following problems and are working to solve them. Thank 
you for your understanding.

No. Description Countermeasures

1 CommStaff operates as primary master on 
Windows 7.  Therefore it cannot operate 
as the secondary master of a multi-
master. Specifically, while another host 
and a HART device are communicating 
continuously with each other, it is not 
possible to connect CommStaff and 
communicate with the HART device.

Do not use simultaneously 
with other HART hosts.

2 The menu can be opened by double-
clicking on the left side of the screen, but 
cannot be opened on the right side. 

Open the menu on the left 
side of the screen.

3 If CommStaff is displayed in full screen 
mode and then terminated, when it starts 
the next time, the screen will not be in full 
screen mode, and a very small screen 
appears instead.

Instead of using full 
screen mode, drag the 
right lower corner of the 
screen to enlarge it to the 
desired size. 

4 In the SFN communication version, the 
Analog Output (current value) display of 
±200 % is shown converted to the 4−20 
mA range. This results in display of the 
erroneous values of –12 mA and 36 mA for 
–200 % and 200 % respectively.

Treat the Analog Output 
values (current values) 
that are converted from % 
output values as reference 
values only. 

5 ATT HART communication version: The 
PV highest  and PV lowest  values are 
created when CommStaff starts, and are 
not updated while CommStaff operates.

To update to the 
latest values, restart 
CommStaff.

6 For all types of the SFN communication 
version:
After adjustment or calibration, the 
message "NOTE-Loop may be returned to 
automatic control" is sometimes mistakenly 
shown as the completion message.

In the SFN communication 
version, the 4−20 
mA current signal will 
be disrupted while 
CommStaff operates, 
so manual control must 
continue.  Do not switch to 
automatic control.
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7 "In some SFN communication versions:In 
the four SFN communication version 
models listed below, during adjustment 
function procedures, the latest values are 
sometimes not shown.
  · ST3000-SFN: Apply values:
  · �AT9000-SFN: Apply values: Zero, 

Span, LRV (Actual)
  · PTG-SFN: Apply values:
  · ALTJ-SFN: Apply values:"

To retrieve and display the 
latest values, select and 
execute “Read new value” 
from the menu.

8 SFN version:
When an SFN communication interface is 
connected to a PC, it will be recognized as 
a COM port and will be assigned a number 
such as COM9. For the CommStaff SFN 
version, the range of legal numbers is 
COM1 to COM16, so if the assigned 
number is COM17 or more, the interface 
will not function.

If COM17 or a higher 
a number is issued, 
change the setting to a 
value between COM1 
and COM16 using 
the Windows Device 
Manager.

9 Parameters are shown as blank until they 
are acquired via communication. 
Also, during this time double-clicking a 
parameter will show an initial value which 
is different from the device value.
Moreover, saving files when a blank is 
displayed will save the initial value, which 
is not the correct value.

To change a parameter, 
wait until it is displayed.
If the device has a 
Review menu, wait until 
the Review menu is 
completely displayed. 
Communication speed 
is slow with SFN 
communications (218 
bps, while HART is 1200 
bps), so for some models 
it takes a few minutes to 
read all the parameters.

10 When executing Auto setup for AVP or 
SVX, the screen may indicate that setup 
is complete even though the device is not 
actually fully set up.

When the control valve 
can execute control in 
response to the input 
signal, Auto setup is 
complete, so wait until that 
time.
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